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Введение в симулятор ONTAP 
Симулятор ONTAP – симулятор для запуска программного обеспечения ONTAP 
позволяющее вам тестировать функции ONTAP без необходимости покупать новое 
оборудование или нарушать производственную среду. 

Симулятор ONTAP – это виртуальная машина VMware, которая работает на 
гипервизоре. Вы можете запустить симулятор в системе Windows или Mac. 

Поддерживаемые приложения VMware 
Вы можете установить симулятор ONTAP только на определенные приложения 
VMware. 

Вам необходимо установить одно из следующих приложений VMware на хост-
системе, чтобы использовать симулятор ONTAP: 

• VMware Workstation Pro 
• VMware Workstation Player 
• VMware Fusion 

Ограничения и неподдерживаемые функции 

Симулятор ONTAP поддерживает большинство функций ONTAP, однако он имеет 
некоторые функциональные ограничения и не поддерживает некоторые функции 
ONTAP из-за архитектуры виртуализации. 

Симулятор ONTAP имеет следующие ограничения: 

• Энергонезависимое ОЗУ (NVRAM) моделируется и не является постоянным. 

Потеря данных может произойти после перезапуска симулятора. Вы должны 
правильно выключить симулятор, чтобы избежать потери данных. 

• Вы можете иметь до четырех смоделированных дисковых полок с 14 дисками 
на полку, всего 56 дисков на симулятор. 

Замечание: Тип диска SSD не поддерживается. 

• Каждый моделируемый диск ограничен 9 ГБ. 

Замечание: Образ симулятора поставляется с предварительно настроенными 
28 дисками емкостью 1 ГБ, по 14 штук на эмулируемых полках 0 и 1. Полки 2 и 3 
не заполнены, однако вы можете настроить до 220 ГБ общего пространства для 
каждого узла симулятора ONTAP. 
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• Вы можете создавать 64-разрядные агрегаты, но их размер ограничен 
максимальным размером моделируемых дисков в 9 ГБ. 

• Симулятор ONTAP не подходит для приложений, требующих высокой 
производительности или интенсивного ввода-вывода. 

• Одновременно могут быть загружены не более двух экземпляров симулятора 
ONTAP. 

Симулятор ONTAP не поддерживает следующие функции: 

• Высокая доступность (CFO / SFO) 
• Подключение по Fibre Channel 
• Модули удаленного управления RLM/BMC/SP 
• CFE, BIOS, прошивку дисковых полок и т.п. 
• Подключение по нескольким путям 

Загрузка ПО симулятора ONTAP 

Программное обеспечение симулятора ONTAP представляет собой набор файлов 
VMware, которые были упакованы в .ova файл. Вам необходимо загрузить 
соответствующее программное обеспечение и файлы лицензий с сайта поддержки 
NetApp. 

Выполните следующие действия: 

1. Войдите на сайт поддержки NetApp по адресу http://mysupport.netapp.com. Вы 
должны быть зарегистрированы на сайте, чтобы иметь возможность скачать 
симулятор. 

2. Перейдите в раздел “Tools”. 
3. В списке инструментов найдите и выберите “Simulate ONTAP”, чтобы открыть 

страницу загрузки. 
4. Примите лицензионное соглашение. 
5. Загрузите симулятор ONTAP (обычно имя файла имеет вид vsim-netapp-

DOTX.Y-cm_nodar.ova, где X.Y – версия ONTAP). 
6. Сохраните файл .ova в соответствующем месте: 

Если вы загружаете в ... тогда... 

Windows Сохраните файл в папку виртуальных машин 

Mac Сохраните файл в папку загрузки 

http://mysupport.netapp.com/
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7. В этом же разделе загрузите файл с лицензиями для симулятора и сохраните 
его на своем компьютере (файл обычно называется CMode_licenses_X.Y.txt, где 
X.Y – версия ONTAP). 

Установка симулятора ONTAP в системе Windows 

Вы можете установить симулятор ONTAP в ОС Windows и протестировать функции 
ONTAP. 

Для запуска симулятора ONTAP в Windows необходимо установить одно из 
следующих приложений VMware: 

• VMware Workstation Pro 
• VMware Workstation Player 

Системные требования Windows 

Перед установкой Симулятор ONTAP в системе Windows вы должны убедиться, что 
выполнены требования к аппаратному и программному обеспечению. Также 
убедитесь, что у вас есть права администратора. 

Требования к оборудованию: 

• Двухъядерная 64-битная система Intel или AMD 
• 5,1 ГБ ОЗУ для одного экземпляра симулятора 
• 10,2 ГБ ОЗУ для двух экземпляров симулятора 
• Не менее 40 ГБ свободного дискового пространства для каждого экземпляра 

симулятора 
• Поддержка VT для системы Intel 

Требования к программному обеспечению: 

• Microsoft Windows 7 или Microsoft Windows 10 
• VMware Workstation Pro или VMware Workstation Player версии 14.1.2 или выше. 

Включение функции VT 
Чтобы установить симулятор ONTAP в системе Windows, необходимо включить 
функцию VT. VT может упоминаться как технология Vanderpool, Virtualization 
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Technology или Virtual Machine Extensions. Настройки VT можно найти в окне 
“Security” или “CPU” в BIOS. 

По умолчанию VT отключен в системах на базе процессоров Intel. 

Последовательность действий: 

1. Получите доступ к BIOS системы во время загрузки вашего компьютера. 
2. В BIOS включите VT, если он еще не включен. 
3. Сохраните изменения в настройках BIOS, а затем выключите систему. 
4. Включите систему снова. 

Замечание: Если вы перезагрузите систему, не выключив ее, технология VT не 
будет включена. 

Установка симулятора ONTAP на VMware Workstation 
Pro 

Вы можете загрузить и установить VMware Workstation Pro на ноутбуке или 
настольном компьютере с Windows, настроить VMware Workstation Pro для работы 
с симулятором ONTAP, запустить виртуальную машину Симулятор ONTAP и 
настроить сетевые адаптеры на VMware Workstation Pro. 

Замечание: Вы не можете установить несколько версий VMware Workstation Pro на 
одном хосте. 

Для получения информации об установке программного обеспечения VMware 
Workstation Pro и документации по VMware Workstation Pro см. веб-сайт VMware 

Дополнительно 

Программное обеспечение VMware Workstation Pro 

Руководство пользователя VMware Workstation Pro 

Запуск симулятора на VMware Workstation Pro 

Вы должны запустить виртуальную машину с симулятором ONTAP в VMware 
Workstation Pro, чтобы получить доступ к консоли симулятора. 

Последовательность действий: 

1. Откройте VMware Workstation Pro. 
2. В окне VMware Workstation выберите File > Open… 
3. В открывшемся окне выберите .ova файл симулятора ONTAP, который вы 

ранее скачали и нажмите кнопку Open. 

http://www.vmware.com/
http://downloads.vmware.com/d/
https://docs.vmware.com/en/VMware-Workstation-Pro
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4. В окне Import Virtual Machine укажите имя и путь к локальному хранилищу для 
новой виртуальной машины, а затем нажмите Import. 

5. На вкладке виртуальной машины щелкните значок Power On this virtual 
machine. 

Установка симулятора ONTAP на VMware Workstation 
Player 

Вы можете загрузить и установить VMware Workstation Pro на ноутбуке или 
настольном компьютере с Windows, настроить VMware Workstation Pro для работы 
с симулятором ONTAP, запустить виртуальную машину Симулятор ONTAP и 
настроить сетевые адаптеры на VMware Workstation Player. 

Для получения информации об установке программного обеспечения VMware 
Workstation Player и документации VMware Workstation Player см. веб-сайт VMware 

Дополнительно 

Программное обеспечение VMware Workstation Player 

Руководство по началу работы с VMware Workstation Player 

Запуск симулятора на VMware Workstation Player 

 

http://www.vmware.com/
http://downloads.vmware.com/d/
https://docs.vmware.com/en/VMware-Workstation-Player
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Вы должны запустить виртуальную машину с симулятором ONTAP для настройки 
ONTAP в консоли VMware Workstation Player. 

Последовательность действий: 

1. Запустите VMware Workstation Player. 
2. В окне проигрывателя VMware Workstation Player щелкните Open a Virtual 

Machine. 

3. В окне Open Virtial Machine выберите .ova файл, который вы ранее скачали и 
нажмите кнопку Open. 

4. В окне Import Virtual Machine укажите имя и путь к локальному хранилищу для 
новой виртуальной машины, а затем нажмите Import 

Симулятор ONTAP откроется в консоли приложения VMware Workstation Player. 
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Установка симулятора ONTAP на Mac 

Вы можете установить симулятор ONTAP в операционной системе Mac OS, чтобы 
протестировать функционал ONTAP. 

Системные требования Mac 

Перед установкой симулятора ONTAP в операционной системе Mac OS (Apple) вы 
должны убедиться, что выполнены требования к аппаратному и программному 
обеспечению. Также убедитесь, что у вас есть права администратора. 

Требования к оборудованию: 

• Процессор не хуже, чем Intel Core 2 Duo 
• 5,1 ГБ ОЗУ для одного экземпляра симулятора 
• 10,2 ГБ ОЗУ для двух экземпляров симулятора 
• Не менее 40 ГБ свободного дискового пространства для каждого экземпляра 

симулятора 
• Поддержка Physical Address Extension (PAE) 

Требования к программному обеспечению: 

• Mac OS X 10 (протестировано на 10.14) 
• VMware Fusion версии 10.1.2 и выше 

Установка симулятора ONTAP на VMware Fusion 

Вы можете загрузить и установить VMware Fusion на ноутбуке или настольном 
компьютере с Mac OS, настроить VMware Fusion для работы с симулятором 
ONTAP, запустить виртуальную машину Симулятор ONTAP и настроить сетевые 
адаптеры на VMware Fusion. 

Для получения информации об установке программного обеспечения VMware 
Fusion и документации VMware Fusion см. Веб-сайт VMware, 

Дополнительно 

Программное обеспечение VMware Fusion 

Документация по VMware Fusion 

 

 

http://www.vmware.com/
http://downloads.vmware.com/d/
https://docs.vmware.com/en/VMware-Fusion
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Добавление симулятора в VMware Fusion 

Чтобы установить Симулятор ONTAP в VMware Fusion, необходимо добавить 
симулятор ONTAP в библиотеку виртуальных машин с помощью программного 
обеспечения VMware Fusion. 

Последовательность действий: 

1. На рабочем столе нажмите Applications. 
2. В окне приложений выберите VMware Fusion. 

3. Нажмите Cancel на экране Installation Method. 
4. Нажмите File > Import. 
5. В окне Choose an Existing Virtual Machine выберите .ova файл, который вы 

ранее скачали, и нажмите Continue. 
 

6. Введите имя новой виртуальной машины в текстовом поле Save As и нажмите 
Save. 
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7. В окне Finished нажмите Finish для запуска виртуальной машины. 

Добавленная виртуальная машина Симулятор ONTAP появится в библиотеке 
виртуальных машин. 

Запуск симулятора в VMware Fusion 

Вы должны запустить виртуальную машину симулятора ONTAP для настройки 
ONTAP в консоли VMware Fusion. 

Последовательность действий: 

1. На рабочем столе нажмите Applications. 
2. В окне приложений выберите VMware Fusion. 

3. Нажмите Cancel на экране Select the Installation Method. 
4. Выберите Window > Virtual Machine Library. 
5. Выберите импортированную виртуальную машину и щелкните значок Play, 

чтобы запустить ее. 
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Использование симулятора ONTAP: один узел 

Запустите и настройте кластер с одним узлом, используя симулятор ONTAP, 
VMware и System Manager. 

Последовательность действий: 

1. Через несколько минут после запуска виртуальной машины и инициализации 
системы вы получите сообщение с предложением войти в System Manager для 
завершения настройки кластера. Это сообщение включает в себя ip-адрес. 

Откройте браузер и перейдите по указанному адресу. 
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2. Проигнорируйте сообщения о некорректном сертификате и о том, что 
партнерский узел не найден. 

3. Настройте кластер с одним узлом с помощью System Manager. Следуйте 
инструкциям на экране. Для получения дополнительной информации см. 
Руководство по конфигурированию кластера в документации по ONTAP System 
Manager. 

Использование симулятора ONTAP: два узла 

Запустите и настройте кластер из двух узлов, используя симулятор ONTAP, ПО 
VMware, ONTAP System Manager и командную строку. 

Последовательность действий: 

1. Создайте первую виртуальную машину симулятора ONTAP и назовите ее, 
например, node1. 

2. Включите виртуальную машину node1. 

Внимание: НЕ ОТКРЫВАЙТЕ SYSTEM MANAGER ДО ТЕХ ПОР, ПОКА ЭТО НЕ 
УКАЗАНО В ИНСТРУКЦИИ 

3. Создайте вторую виртуальную машину симулятора ONTAP и назовите ее, 
например, node2. 

https://docs.netapp.com/us-en/ontap/task_configure_ontap.html
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Для объединения двух узлов в кластер необходимо изменить идентификатор 
системы (System ID) и серийный номер (Serial No) второго узла, как описано в 
следующих шагах. 

4. Включите виртуальную машину node2. 
5. Нажмите пробел, как только увидите на экране загрузки надпись: 
Hit [ENTER] to boot immediately, or any other key for command prompt. 

Booting in 10 seconds… 

После этого вы должны увидеть на экране приглашение VLOADER> 

6. Измените идентификатор системы и серийный номер узла node2. Для этого 
внимательно введите следующие команды (VLOADER> – приглашение 
системы): 

VLOADER> setenv SYS_SERIAL_NUM 4034389-06-2 

VLOADER> setenv bootarg.nvram.sysid 4034389062 

7. Убедитесь, что информация была сохранена правильно: 
VLOADER> printenv SYS_SERIAL_NUM 

VLOADER> printenv bootarg.nvram.sysid 

8. Введите команду для загрузки узла: 
VLOADER> boot 
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9. Симулятор начинает процесс загрузки с новым идентификатором системы и 
серийным номером. 

10. После того, как узел node2 загрузится и отобразит приглашение login:, 
вернитесь к узлу node1 и откройте System Manager в окне браузера, используя 
IP-адрес, отображаемый на консоли node1. 

11. Если вы получили сообщение о том, что партнерский узел не найден, 
игнорируйте это сообщение. 

12. Следуйте инструкциям на экране для настройки кластера. Не устанавливайте 
флажок «Set up a single-node cluster» в разделе «Others». Для получения 
дополнительной информации см. Руководство по конфигурированию кластера в 
документации по ONTAP System Manager. 

13. Нажмите «Submit». 
14. После успешного конфигурирования кластера вы будете перенаправлены на 

указанный в настройках IP-адрес кластера. 
15. Войдите в System Manager, используя имя пользователя admin и пароль, 

заданный ранее. 
16. Откройте слева меню Network > Overview и в разделе Network Interfaces 

запишите или запомните один из IP-адресов с типом Cluster (они имеют вид 
169.254.xx.yy). 

https://docs.netapp.com/us-en/ontap/task_configure_ontap.html
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17. Перейдите в консоль виртуальной машины node2, войдите с именем 
пользователя admin без пароля и введите следующую команду, чтобы 
присоединиться в кластер к node1: 

::> cluster join -clusteripaddr <IP-адрес из предыдущего шага> 

Подождите, пока не появится сообщение «This node has joined to cluster». 

Исследование ONTAP 

Исследуйте ONTAP с помощью симулятора и Центра документации ONTAP. 

Устранение проблем 

Если IP-адрес не был настроен автоматически, выполните следующие шаги: 

1. Откройте командную строку и выполните команду «ipconfig» в Windows и 
«ifconfig» в Mac OS. 

2. Ищите сетевой адаптер «VMware Network Adapter VMnet8» в Windows или 
«vmnet8» в Mac OS. 

Пример для Windows: 

https://docs.netapp.com/ontap-9/index.jsp
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Ethernet adapter VMware Network Adapter VMnet8: 
Connection-specific DNS Suffix  . . . . . . . : 
Link-local IPv6 Address. . . . . . . . . . . .: fe80::3179:c654:ddb2:7dfc%11 
IPv4 Address. . . . . . . . . . . . . . . . . : 192.168.201.1 
Subnet Mask  . . . . . . . . . . . . . . . . .: 255.255.255.0 
Default Gateway . . . . . . . . . . . . . . . : 

Пример для Mac OS: 
vmnet8: 
flags=8863<UP,BROADCAST,SMART,RUNNING,SIMPLEX,MULTICAST> mtu 1500 
ether 00:50:56:c0:00:08 
inet 172.16.208.1 netmask 0xffffff00 broadcast 172.16.208.255 

3. Выберите неиспользуемый IP-адрес из подсети «IPv4 Address» в Windows и 
«inet» Mac OS. 

4. Войдите в консоль виртуальной машины и выполните следующую команду для 
настройки IP-адреса. 

network interface create -vserver Default -lif mgmt_auto -role 
node-mgmt -address <IP-адрес из шага 3> -netmask <маска подсети 
из шага 2> -home-port e0c 

5. Войдите в ONTAP System Manager, используя ссылку: 
https://<IP-адрес из шага 3> 

Приложение A: Настройка доступа к сети через 
порт Ethernet 

По умолчанию сетевые адаптеры 3 и 4 симулятора ONTAP настроены как NAT / 
Share with my MAC. Чтобы получить доступ и смонтировать тома, созданные в 
симуляторе ONTAP через физический порт Ethernet ноутбука, измените сетевой 
адаптер 4 на Bridged / Thunderbolt Ethernet и используйте сетевой порт e0d в 
симуляторе ONTAP для монтирования томов. Это работает, только если IP-адреса 
и подсеть являются статическими. 
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